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PDF Map Adelaide, Australia, printable vector street City Plan map V3-2016.08, full editable, Adobe PDF, full vector, scalable, editable, text format  street names, 38 mb ZIP

All streets, some more buildings. Map for design, printing, arts, projects, presentations, for architects, designers and builders, business, logistics.

The most accurate and detailed map of the city.

You can edit this file by Adobe Illustrator, Adobe Acrobat, Corel Draw.


SKU: 2016.15.08.AD.AU.CP.FU.V3.PDF

Share this map for your friends!
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Adelaide Australia City Vector Map, Adelaide Australia Map, AutoCAD Map Adelaide Australia, City Map Adelaide Australia, City Plan Adelaide Australia, CorelDraw Map Adelaide Australia, DWG Map Adelaide Australia, DXF Map Adelaide Australia, Editable Map Adelaide Australia, Illustrator Map Adelaide Australia, Map Adelaide Australia for Printing, PDF Map Adelaide Australia: Editable Vector Maps, printable map Adelaide Australia, Road Map Adelaide Australia, Street Map Adelaide Australia, Tourist Map Adelaide Australia, Urban Plan Adelaide Australia, vector map Adelaide Australia

Map Categories



Australia cities and country vector maps: PDF and Adobe Illustrator, Australia maps

Extended Description of the Vector Map



Adelaide, Australia, printable vector street City Plan map V3-2016.08, full editable, Adobe PDF, full vector, scalable, editable, text format  street names, 38 mb ZIP

All streets, some more buildings. Map for design, printing, arts, projects, presentations, for architects, designers and builders, business, logistics.

The most accurate and detailed map of the city.

You can edit this file by Adobe Illustrator, Adobe Acrobat, Corel Draw.

DXF, DWG, CDR and other formats – on request, same price, please, contact

 

 

Adelaide, South Australia.

This vector map of Adelaide city is used as a basis for design, editing, and further printing.

This is the most detailed, exact map of Adelaide city for high-quality printing and polygraphy. You can always clarify the map development date by contacting us.

For your convenience, all objects on Adelaide vector city map are divided into layers. And the editing is very easy – colors, lines, etc.

You can easily add any objects needed (e.g. shops, salons, sale points, gas station or attraction) on any layer of Adelaide vector map.

Adelaide is the capital city of the state of South Australia, and the fifth-most populous city of Australia. In June 2017, Adelaide had an estimated resident population of 1,333,927. Adelaide is home to more than 75 percent of the South Australian population, making it the most centralised population of any state in Australia.



One of the advantages of Adelaide city vector maps of our production is the relevance of cartographic data, we constantly update all our products.

This vector map of Adelaide city is used by:

designers, layout designers, printers, advertisers and architects. Our product – vector maps – is designed for further editing and printing in large formats – from @Wall format (a few meters) to A-0 and A-1, A-2, A-3.

The Adelaide city map in vector format is used for design, urban planning, presentations and media visualizations.

The advertising and presentation map of Adelaide city (usually the final designer marks the routes, and puts the client’s objects (shops, saloons, gas stations etc.)

The undoubted advantage is that people will NEVER throw out this advertising product – the map. In fact, as an advertising medium, a city map is the most “long-playing” of the well-known polygraphic advertising media, with the longest lifespan, and the maximum number of interactions with the customer.

For travelers, maps are sold at the airports and gas stations around the world. Often the source is our vector maps.



Take a look, who purchases our vector maps of Adelaide city in “Our Clients and Friends” page – these are large and small companies, from super-brands like Volvo and Starbucks, to small design studios and printing houses.

It’s very easy to work with vector maps of Adelaide city, even for a not very experienced designer who can turn on and off the map layers, add new objects, change the colors of fill and lines according to customer requirements.

The undoubted advantage of Adelaide city vector maps in printing is an excellent and detailed visualization, when customer can expand a large paper map and instantly define his location, find a landmark, an object or address on map, unlike using the popular electronic formats of Google and Yandex maps for example.

Printable vector maps of Adelaide city are much more convenient and efficient than any electronic maps on your smartphone, because ALL DETAILS are displayed in the entire space of Adelaide city map.

Adelaide is north of the Fleurieu Peninsula, on the Adelaide Plains between the Gulf St Vincent and the low-lying Mount Lofty Ranges which surround the city. Adelaide stretches 20 km (12 mi) from the coast to the foothills, and 94 to 104 km (58 to 65 mi) from Gawler at its northern extent to Sellicks Beach in the south.



Useful tips on working with vector maps of cities and countries in Adobe Illustrator.

«V» – launches the Selection tool (cursor, black arrow), which makes active any vector line.

«А» – launches the Direct Selection tool (white cursor), allows you to select curve elements and drag them to the desired place.

«R» – activates the Rotate tool, which helps you rotating selected objects around the center point by 360 degrees.

«E» – gives you the opportunity to use the Eraser tool and erase unnecessary parts.

«X» – switches between Fill and Stroke in the Tools section. Try to get used to this hot key and

you will quickly understand that you can’t live and work without it.

Named in honour of Adelaide of Saxe-Meiningen, queen consort to King William IV, the city was founded in 1836 as the planned capital for a freely-settled British province in Australia. Colonel William Light, one of Adelaide’s founding fathers, designed the city and chose its location close to the River Torrens, in the area originally inhabited by the Kaurna people.



Guides are not limited to vertical and horizontal in Adobe Illustrator. You can also create a diagonal guide for example. Moreover, you can turn any contours into guides. Select the outline and go to View > Guides > Make Guides (Create Guides), or simply press Cmd/Ctrl + 5. You can also turn the guides back into an editable object. Go to menu, View > Guides > Unlock Guides (Release Guides), select the guide you want to edit and select View > Guides > Release Guides (Reset Guides), or just press Cmd/Ctrl + Option / Alt + 5).

You will probably want to change the color scheme used on our Adelaide vector city map.

To quickly and effectively play with colors.

Of course, you can do it manually, all objects in our Adelaide city vector map are divided according to types and layers, and you can easily change the color gamma of vector objects in groups and layers.

Light’s design set out Adelaide in a grid layout, interspaced by wide boulevards and large public squares, and entirely surrounded by parklands. Early Adelaide was shaped by prosperity and wealth—until the Second World War, it was Australia’s third-largest city and one of the few Australian cities without a convict history. It has been noted for early examples of religious freedom, a commitment to political progressivism and civil liberties.



Create and edit color groups of Adelaide city vector map, and also assign colors using the «Edit Colors»/ а «Repaint Graphic Object» dialog box.

A. Creating and editing of a color group on the «Edit» tab

B. Assigning colors on the «Assign» tab

C. Select a group of colors from the «Color groups» list

The option «Repaint a graphic object» in the lower part of the dialog box allows you to preview the colors on a selected layer of Vector map, or a group of elements, and specify whether its colors will be redefined when the dialog box is closed.

As South Australia’s seat of government and commercial centre, Adelaide is the site of many governmental and financial institutions. Most of these are concentrated in the city centre along the cultural boulevard of North Terrace, King William Street and in various districts of the metropolitan area. Today, Adelaide is noted for its many festivals and sporting events, its food and wine, its long beachfronts, and its large defence and manufacturing sectors. It ranks highly in terms of quality of life, being consistently listed in the world’s top 10 most liveable cities, out of 140 cities worldwide by The Economist Intelligence Unit. It was also ranked the most liveable city in Australia by the Property Council of Australia in 2011, 2012 and 2013.



The main areas of the dialog box are:

«Edit»

The «Edit» tab is designed to create a new or edit the existing color groups.

The harmony rules Menu and the Color Wheel are used to conduct experiments with color harmonies. The color wheel shows how colors are related in color harmony, and the color bars allow you to view and manipulate an individual color values. In addition, you can adjust the brightness, add and remove colors, save color groups and view colors on the selected Vector Map of Adelaide city or a separated layers.

«Assign»

The «Assign» tab is used to view and control on how the original colors are replaced with colors from the color group like your corporate colors in the Vector Map of Adelaide city.

The assign color ability is provided only if the entire map, layer or fragment is selected in the document. You can specify which of new colors replace the current colors, whether the spot colors should be preserved and how colors are replaced (for example, you can replace colors completely or changing the color tone while maintaining the brightness). The «Assign» tab allows you to redefine colors in the Vector Map of Adelaide city, or in separate layers and fragments using the current color group or reducing the number of colors in the current Vector Map.

Geography

Adelaide is north of the Fleurieu Peninsula, on the Adelaide Plains between the Gulf St Vincent and the low-lying Mount Lofty Ranges. The city stretches 20 km (12 mi) from the coast to the foothills, and 90 km (56 mi) from Gawler at its northern extent to Sellicks Beach in the south. According to the Regional Development Australia, an Australian government planning initiative, the “Adelaide Metropolitan Region” has a total land area of 870 km2 (340 sq mi), while a more expansive definition by the Australian Bureau of Statistics defines a “Greater Adelaide” statistical area totalling 3,257.7 km2 (1,257.8 sq mi).



Color groups

Is a list of all saved color groups for current document (the same groups appear in the «Samples» palette). You can edit and delete the existing color groups, as well as creating a new ones using the list of “Color Groups” in the dialog box. All changes appear in the «Samples» palette.

The highlighted color group shows, which color group is currently edited.

Any color group can be selected and edited, or used to redefine the colors in the selected vector map of Adelaide city, its fragments or elements.

The city sits at an average elevation of 50 metres (160 ft) above sea level. Mount Lofty, east of the Adelaide metropolitan region in the Adelaide Hills at an elevation of 727 metres (2,385 ft), is the tallest point of the city and in the state south of Burra.



Saving a color group adds this group to the specified list.

Opening the «Edit Colors»/«Repaint Graphic Object» dialog box.

Open the «Edit Colors»/«Repaint Graphic Object» dialog box using one of the following methods:

«Edit»> «Edit Colors»> «Repaint Graphic object» or «Repaint With Style».

Use these commands if you need to edit the colors in the selected vector map of Adelaide city.

«Repaint Graphic object» button on the «Control» panel.

Use this button if you need to adjust colors of Adelaide city vector map using the а «Repaint graphic object» dialog box.

Much of Adelaide was bushland before British settlement, with some variation – sandhills, swamps and marshlands were prevalent around the coast. The loss of the sandhills to urban development had a particularly destructive effect on the coastline due to erosion. Where practical, the government has implemented programs to rebuild and vegetate sandhills at several of Adelaide’s beachside suburbs. Much of the original vegetation has been cleared with what is left to be found in reserves such as the Cleland Conservation Park and Belair National Park.



The specified button is available if the selected vector map or its fragment contains two or more colors.

Note. This color editing method is convenient for global color adjustment in a vector map, if global colors were not used when creating a City Map of Adelaide.

The «Edit colors» button or «Edit or apply colors» on the «Color Catalog» palette

Click this button if you need to edit colors on the «Color Catalog» palette or edit and then apply them to the selected Vector Map of Adelaide city or its fragment.

The «Edit color group» button or «Edit or apply color group» on the «Samples» palette.

A number of creeks and rivers flow through the Adelaide region. The largest are the Torrens and Onkaparinga catchments. Adelaide relies on its many reservoirs for water supply with the Happy Valley Reservoir supplying around 40% and the much larger Mount Bold Reservoir 10% of Adelaide’s domestic requirements respectively.



Click this button if you need to edit the colors in the specific color group or edit and apply them to the selected Vector Map of Adelaide city or a group of its elements, for example, the whole layer “Streets and lines”. You can also double-click the color group in the Samples panel to open the dialog box.

If the map file is too large and your computer freezes or even can’t open it quickly:

1. Try to reduce the color resolution of the video card (display) to 256 colors while working with a large map.

2. Using Windows Task Manager, select all the application you don’t need, while working with map, just turn them off.

3. Launch Adobe Illustrator. (DO NOT OPEN the vector map file)

4. Start the Windows Task Manager using administrator rights > Find the “Illustrator” process > set the «real time» priority,

5. Open the file. When you see the LEGACY FONT popup window – click “OK” (do not update). You can restore the TEXT later.

6. Can also be useful: When file is opened – Edit > Settings > Basic Settings > disable smoothing. /// It looks scary, but works quickly)))

We recommend saving the file in Adobe Illustrator 10 version. It’s much more stable when working with VERY BIG size files.

Adelaide and its surrounding area is one of the most seismically active regions in Australia. On 1 March 1954 at 3:40 am Adelaide experienced its largest recorded earthquake to date, with the epicentre 12 km from the city centre at Darlington, and a reported magnitude of 5.6. There have been smaller earthquakes in 2010, 2011, 2014 and 2017.



Urban layout

Adelaide is a planned city, designed by the first Surveyor-General of South Australia, Colonel William Light. His plan, now known as Light’s Vision, arranged Adelaide in a grid, with five squares in the Adelaide city centre and a ring of parks, known as the Adelaide Parklands, surrounding it. Light’s selection of the location for the city was initially unpopular with the early settlers, as well as South Australia’s first governor, John Hindmarsh, due to its distance from the harbour at Port Adelaide, and the lack of fresh water there. Light successfully persisted with his choice of location against this initial opposition.



The benefits of Light’s design are numerous: Adelaide has had wide multi-lane roads from its beginning, an easily navigable cardinal direction grid layout and an expansive green ring around the city centre. There are two sets of ring roads in Adelaide that have resulted from the original design. The inner ring route (A21) borders the parklands, and the outer route (A3/A13/A16/A17) completely bypasses the inner city via (in clockwise order) Grand Junction Road, Hampstead Road, Ascot Avenue, Portrush Road, Cross Road and South Road.

Suburban expansion has to some extent outgrown Light’s original plan. Numerous former outlying villages and “country towns”, as well as the satellite city of Elizabeth, have been enveloped by its suburban sprawl. Expanding developments in the Adelaide Hills region led to the construction of the South Eastern Freeway to cope with growth, which has subsequently led to new developments and further improvements to that transport corridor. Similarly, the booming development in Adelaide’s South led to the construction of the Southern Expressway.



New roads are not the only transport infrastructure developed to cope with the urban growth. The O-Bahn Busway is an example of a unique solution to Tea Tree Gully’s transport woes in the 1980s. The development of the nearby suburb of Golden Grove in the late 1980s is an example of well-thought-out urban planning.

In the 1960s, a Metropolitan Adelaide Transport Study Plan was proposed in order to cater for the future growth of the city. The plan involved the construction of freeways, expressways and the upgrade of certain aspects of the public transport system. The then premier Steele Hall approved many parts of the plan and the government went as far as purchasing land for the project. The later Labor government elected under Don Dunstan shelved the plan, but allowed the purchased land to remain vacant, should the future need for freeways arise. In 1980, the Liberal party won government and premier David Tonkin committed his government to selling off the land acquired for the MATS plan, ensuring that even when needs changed, the construction of most MATS-proposed freeways would be impractical. Some parts of this land have been used for transport, (e.g. the O-Bahn Busway and Southern Expressway), while most has been progressively subdivided for residential use.



In 2008, the SA Government announced plans for a network of transport-oriented developments across the Adelaide metropolitan area and purchased a 10 hectare industrial site at Bowden for $52.5 million as the first of these developments. The site covers 102,478 square metres, or about 10 hectares, and is bounded by Park Terrace to the south, the Adelaide to Outer Harbour railway line to the west, Drayton Street to the north and Sixth and Seventh Streets to the east.



 

Adelaide is the capital city of the state of South Australia, and the fifth-most populous city of Australia. In June 2014, Adelaide had an estimated resident population of 1.3 million. South Australia, with a total of 1.7 million inhabitants, has the most centralised population of any state in Australia, with more than 75 percent of its people living in greater Adelaide, while the other population centres in the state are relatively small.

The demonym “Adelaidean” is used in reference to the city and its residents. Adelaide is north of the Fleurieu Peninsula, on the Adelaide Plains between the Gulf St Vincent and the low-lying Mount Lofty Ranges which surround the city. Adelaide stretches 20 km (12 mi) from the coast to the foothills, and 94 to 104 km (58 to 65 mi) from Gawler at its northern extent to Sellicks Beach in the south.

Named in honour of Adelaide of Saxe-Meiningen, queen consort to King William IV, the city was founded in 1836 as the planned capital for a freely-settled British province in Australia. Colonel William Light, one of Adelaide’s founding fathers, designed the city and chose its location close to the River Torrens, in the area originally inhabited by the Kaurna people. Light’s design set out Adelaide in a grid layout, interspaced by wide boulevards and large public squares, and entirely surrounded by parklands. Early Adelaide was shaped by prosperity and wealth—up until the Second World War, it was Australia’s third largest city. It has been noted for early examples of religious freedom, a commitment to political progressivism and civil liberties. It has been known as the “City of Churches” since the mid-19th century.

As South Australia’s seat of government and commercial centre, Adelaide is the site of many governmental and financial institutions. Most of these are concentrated in the city centre along the cultural boulevard of North Terrace, King William Street and in various districts of the metropolitan area. Today, Adelaide is noted for its many festivals and sporting events, its food and wine, its long beachfronts, and its large defence and manufacturing sectors. It ranks highly in terms of liveability, being listed in the Top 10 of The Economist Intelligence Unit’s World’s Most Liveable Cities index in 2010, 2011, 2012 and 2015. It was also ranked the most liveable city in Australia by the Property Council of Australia in 2011, 2012 and 2013.

Coordinates 34°55′44.4″S 138°36′3.6″E

Population 1,304,631 (2014) (5th)

• Density 396.4/km2 (1,027/sq mi) (2011)

Established 28 December 1836

Area 3,257.7 km2 (1,257.8 sq mi)

Time zone ACST (UTC+9:30)

• Summer (DST) ACDT (UTC+10:30)

Location

654 km (406 mi) NW of Melbourne

958 km (595 mi) West of Canberra

1,161 km (721 mi) West of Sydney

1,600 km (994 mi) SW of Brisbane

2,130 km (1,324 mi) East of Perth



Download This Free Vector Map Australia Adelaide Location >>>>>

Adelaide_Free_Vector_Map_Australia_location_map.ai

Geography.

Adelaide is north of the Fleurieu Peninsula, on the Adelaide Plains between the Gulf St Vincent and the low-lying Mount Lofty Ranges. The city stretches 20 km (12 mi)  from the coast to the foothills, and 90 km (56 mi) from Gawler at its northern extent to Sellicks Beach in the south. According to the Regional Development Australia, an Australian government planning initiative, the “Adelaide Metropolitan Region” has a total land area of 870 km2 (340 sq mi), while a more expansive definition by the Australia Bureau of Statistics defines a “Greater Adelaide” statistical area totalling 3,257.7 km2 (1,257.8 sq mi). The city sits at an average elevation of 50 metres (160 ft) above sea level. Mount Lofty, east of the Adelaide metropolitan region in the Adelaide Hills at an elevation of 727 metres (2,385 ft), is the tallest point of the city and in the state south of Burra.

Much of Adelaide was bushland before British settlement, with some variation – sandhills, swamps and marshlands were prevalent around the coast. The loss of the sandhills to urban development had a particularly destructive effect on the coastline due to erosion. Where practical, the government has implemented programs to rebuild and vegetate sandhills at several of Adelaide’s beachside suburbs. Much of the original vegetation has been cleared with what is left to be found in reserves such as the Cleland Conservation Park and Belair National Park. A number of creeks and rivers flow through the Adelaide region. The largest are the Torrens and Onkaparinga catchments. Adelaide relies on its many reservoirs for water supply with the Happy Valley Reservoir supplying around 40% and the much larger Mount Bold Reservoir 10% of Adelaide’s domestic requirements respectively.

Adelaide and its surrounding area is one of the most seismically active regions in Australia. On 1 March 1954 at 3:40 am Adelaide experienced its largest recorded earthquake to date, with the epicentre 12 km from the city centre at Darlington, and a reported magnitude of 5.6. There have been smaller earthquakes in 2010, 2011 and 2014.

https://en.wikipedia.org/wiki/Adelaide

See also Printable and editable vector street maps of Australia`s cities:

For example:

+Vector street map of Canberra, Australia printable and editable



Author: Kirill Shrayber, Ph.D.

I have been working with vector cartography for over 25 years, including GPS, GIS, Adobe Illustrator and other professional cartographic software.

Linkedin: https://www.linkedin.com/in/kirill-shrayber-0b839325/

Twitter: https://twitter.com/vectormapper








See more maps of this city / area / state / country




	
				

Adelaide Australia City Vector Map Exact High Detailed Urban Plan editable Adobe Illustrator Street Map in layers
$ 53.00

	



	
				

Adelaide Australia City Vector Map PDF: Exact High Detailed Urban Plan editable Adobe PDF Street Map in layers
$ 53.00

	



	
				

Adelaide Australia Printable Vector PDF Map, exact City Plan, full editable Adobe PDF, scale 1:61608, text format all names, All ZIPcodes areas (POA) Street Map
$ 49.00

	



	
				

Adelaide DWG City Plan vector Map Metro Area, Australia, full editable, AutoCAD 100 meters scale
$ 59.00

	



	
				

Adelaide Map CorelDraw vector Metro Area City Plan Australia, full editable, Street Map Corel Draw
$ 59.00

	



	
				

Adelaide Map Vector Australia Printable detailed street map V3.11 City Plan editable 100 m scale CorelDraw
$ 48.00

	




	




	









		
	
	


	
		







US: US: SOLCITY NAV, LLC

651 N Broad St Suite 201

Middletown, DE US

+1(786) 292-6893 



Tel. Whatsapp: +1.829.4100078
Restauracion 261, Santo Domingo, Distrito Nacional, 11903
vectormapper@gmail.com
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